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How to write an eBook — for newbies.
Introduction.

The very book you are starting to read right now, is an eBook on how to write an
eBook. It is also an eBook which describes, or is linking to, everything you need
to make your own website where you can sell your eBook.

Why do I do this?

Two days ago, I noticed a cry for help in one of my incoming mailboxes. It was
from a newbie who tried to make an eBook, and had failed and stopped the
project. The reason was that he/she had used all trial admissions for Acrobat
Reader, and it was now locked to her/him. Well, such things happen, but I felt
pretty bad about the email, because it was 12 days old, and I hadn’t answered it
yet!

I started writing her/him an email, but then I thought: If she/he is in trouble, there
must be many more out there. I have also received several emails about the same
theme, since some may think I know much about the techniques of writing an

eBook, having eBooks for download on my own site,
http://www.databasedesign-resource.com. That site is built with the best web
design tool around: SiteBuildIT! See more on this later.

However, I am not an expert at this, but [ have managed to make a couple of
eBooks, upload them to my site, and offer them for sale. The purpose of this
eBook is to show you how I do it, and most important, without spending money
on doing it.

Right on: Your most important tool.

Your most important tool is Microsoft Word. I started Word 10 minutes ago, and I
am now writing this page. When I have it finished, I select File -> Save, and I
make a new folder:
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and save this file. [ name it Introduction.doc. I will now make a chapter about

how I use Word, so I save and close this file. See you in the next chapter.

BTW, the graphics in this eBook may look a little blurred on your screen. It is the
fault of the PDF viewer. If you print this eBook, all images will be nice and sharp.
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Using Microsoft Word.
Welcome back.

I use Word for all writing. For every chapter [ make a new document. I will later
show you how to put them together. BTW: You can use any word processor that
can print to a printer.

I am not a professional Word user. Actually, I just know the basics of it. I do not
know all the fancy stuff, like indexes, and making a table of content is rocket
science © to me. I do not like it.

I just want to write, and make it look OK. So if I can utilize Word in my work,
everybody can. The basics are: You should have a standardized look and feel to
each chapter.

Basically, that’s it: Write the different chapters of your eBook, save each as a
separate document, and preferably in a dedicated folder for your eBook.

Now let us assume all your chapters are written, and you want to put them
together. Once more, you use Word. Create a new document, but this time, you do

as follows:
Select View -> Outline:
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You now have an empty master document with a small tag. This tag is where you
will put in your subdocuments (Each of them is one chapter in your eBook). You
should have gotten a toolbar on master- and subdocuments, like this:

Fupdaetoc [{] O] B & 22 B 5 4.

Click on this one T to insert a new subdocument:
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Double-click on the chapter you want to insert, and it goes straight into your
master document. You continue like this until all your chapters are in place.
Notice that every chapter opens with a view of all the text, but the master
document is really just pointing to the filename of each chapter. When all chapters
are in, choose File -> Save and save the master document, just as any other Word
document. Close Word and start it up again, and open your master document
again. You will get something like this (Remember, I have just started this writing
so I just have two chapters to show you right now):

i3l NewbieBook.doc - Microsoft Word
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You see? The master document is just a set of pointers to your chapters. You can
expand and collapse the master document as you wish, but you do NOT edit any
content here; you do that in each chapter itself. The only thing you do in your
master document, is to correct eventual unnecessary page breaks. You may spot
them as blank lines with a little tag between two subdocuments.

Your eBook is now ready for production.



Producing the eBook.
This is the vital step in building your eBook.

Before we continue, [ want to make one thing clear: The software [ am
mentioning is used by agreement between yourself and the provider of it, and it is
a business between you and the provider. The links are placed here for your
convenience only, so you can get hold of the necessary resources fast and simple.

You can, of course, just publish your Word documents as they are. But; others
may easily copy and change it, and the size can be large. A big problem is Word
itself: Not everyone have it, and there may be version problems as well. So we
will not explore that option further.

At first, I believed that I needed to use special eBook software (SW) to produce
eBooks, so I invested 30 USD in an eBook compiler program. It produces very
nice eBooks with lots of possibilities, and I would have loved to use it as my
standard. Unfortunately, it has two disadvantages:

The size of the eBook grows large; more than 1 Mb compared to PDF at 300 Kb,
and; the output is an EXE file. That makes it a risky object: When you start an exe
file, it is a computer program. In these times of viruses, you really have to trust
the sender of an exe file in order to run it. Your readers will probably trust you, to
some degree, but to the extent of executing your exe file? It is a potential
showstopper for you.

So I have decided, also after some advice from others, that [ want to wrap the
eBook into a popular format, and the PDF format can be read by everyone with a
PDF reader, such as Acrobat Reader. It is free SW, and you get it here:

http://www.adobe.com/products/acrobat/readstep2.html

But, first YOU must be able to convert your Word master document into PDF!

There are many tools on the market; and most of them have a price to it. Some are
really expensive. | was looking high and low for a tool which was free to use. I
first found a tool called Cute PDF Printer, and it produced absolutely perfect PDF
for me.

I was really happy for a whole day.

By the way, I found it by searching on http://www.download.com. Go there and
search if you are looking for free SW. The cute PDF proved fantastic at first
glance, but then I started to find the limitations: It could not convert links I had in
my eBook, it couldn’t produce page numbers, and it couldn’t produce bookmarks
(table of content with links), and quite many other options. Cute PDF did only one
thing: It converted my Word documents into PDF.

I continued searching.
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Then I found the SW I am using now: The pdf995 software. This really does the
job I want, with a couple of limitations that I can live with.

The basic principle of both (all?) PDF producing software packages, is as follows:
It installs itself as a printer driver (it looks like a printer to you), but instead of
printing to your printer, it prints to a file, and the “printed” result is a PDF file!
Very nice. With the pdf995 package comes a program called pdfedit995. This
program allows you to modify certain properties of the finished PDF file. We will
be going through that in detail later.

For now, you have to go and get the pdf995 software, download it and install it.
You will need to get both pdf995 and pdfEdit995. They are both free to use, with
a little string attached: Each time you use their software, Internet Explorer starts
on your PC with an ad for their site. This happens ONLY on your site, NOT at the
users who download your eBook. It is just a small nuisance for you, but you can
buy yourself out of it by paying USD 19.95 to them.

I haven’t paid them yet, but I will, as I find their SW very helpful to me. It is a
matter of ethics for me... : They provide me with good software, and aren’t
pushing anything, but I am sure they need the money, and both I and you can
afford that kind of money.

After all, you have the best intentions of making more than 20 bucks on your
eBook, haven’t you?

So, follow this link, http://www.pdf995.com, close my eBook, and come back
when you are ready to “print” a PDF file.
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Producing the PDF file
Since you are back, you obviously have installed the pdf995 SW.

Start Word and open your master document again. Choose Preview document.
You will get the following message:

Microsoft Word ) x|

\.13') Do wou want ko open the subdocuments befare continuing with this cormmand?

Yes Mo | Zancel |

Click Yes, and you can now preview your eBook. If it looks OK, you are ready to
go on, if not, go back and edit each chapter until you are satisfied. If you have
unwanted page breaks, they may come either from each subdocument, or from
unwanted breaks between the subdocuments in your master document.

Close the preview window, and select File -> Print. Instead of printing it to your
ordinary printer, you choose the PDF995 printer driver:
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Now, select Properties, and select the Page Order as Back to front:
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Press OK, and then “print” the document.

You will be asked where you want to place the document. Choose the same
directory on your hard-disk as the other files for your eBook project. Your file
will be produced in a few seconds. An Internet Explorer window is popping up.
Just click it down or close it. It is that little commercial that I mentioned earlier.
As I said, you can pay your way out of that.

You can now look at your eBook. Browse to your eBook project folder, and
double-click on the PDF file there:

ments'5BIMaking an eBook
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and Acrobat Reader shows you the result: Pretty good, so far.

Now you can continue to edit your chapters, page breaks and so on. When you are
completely finished, and the eBook is ready for the final (production) version, you
generate it for the last time, and then you will use the pdfEdit995 for the last,
finishing touchups.

The pdf995 only produces the PDF itself; bookmarks, page numbesr, links and
everything else are done by pdfEdit995. The problem, and limitation with this, is
that if you wish to produce a new version of your PDF eBook, you must do that
work from scratch again.

There is no persistence here: The PDF producing pdf995 does not take notice of
the modifications you do with pdfEdit995. I know, it is too bad, but that is life.
Accept it, or pay for something that will do it. I can live with this; it is not that
much work.

VERY IMPORTANT!

Up till now, we have talked about using Word. What if you wanted to upload an
Excel spreadsheet? Or something else? Here is the good news:

EVERYTHING YOU CAN PRINT, YOU CAN PRINT TO PDF995!

That opens a new perspective, doesn’t it?



Modifying the PDF file

Basically, there are four kinds of modifications I would want to do in my PDF
file:

Add page numbers

Add bookmarks (table of content which jumps to the desired chapter)
Activate external links in the text

Add word-links (links under ordinary text)

el s

In addition, I would like to put my personal profile on it.
I use the pdfEdit995 program for all these tasks.

First, be sure your PDF file is not open. It must be closed in order to change the
content. Closed means simply that you do not have it opened in Acrobat Reader.

Start the pdfEdit995 program. This program will always operate on the last PDF
file you have created; in your case, your newly “printed” eBook.

You will get this screen:

=E

Wwieh Wiew I Forts I Confidential I Stationery I Text I Image I Batch
Page Murnber I Bookmark I Links I Docinfo
Cambine | Fiotate I &utalaunch I Sto-H ame | Page Size

[ Add new pdfass print jobs to the last document

Help |

By the way, the same annoying Internet Explorer window will start again. Just
close it.



Now select Page Number:

Fage Mumber B ookmark Lirks Doclmfa

Mote: In order to number the last document printed., it must not be open in the viewer.

Farit size: IE Starting page humber: I'I

Add page numbers to the last document printed

and click on Add page numbers..........
That’s it; the eBook has now got page numbers in it.
Then click on links:

Page Nurnber I Bookmark Links " Dodnfa

Mate: In order to add links the [azt document printed must not be open in the viewer.

— Corvert zpecified text to links

Teut: I

Corveert Test to
Linkz

URL: |

Auto-Comvert URL's to links

and click on Auto-Convert.....

This will make all your direct URL’s active. They will now start a browser
window for the link that the reader clicks on. Great job so far.
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Now I want to convert some text to links: Wherever I have the word email, I want
it to be an active email link to me:

Fage Murnber I B ookrmark Linkz Doclnfo

Mate: In order to add links the last document printed must not be open in the viewer,

Convert specified text to links

Text: IEmaﬂ

Corvert Test o
Lirkz

LIRL: ImaiItD: inforEidatabasedesign-resource. con

Auto-Convert UBL's to links

Enter your text, your URL, and press Convert Text to Links. That’s it.

Here is one limitation of pdfEdit995 I dislike: Although I can specify a phrase
(two or more words), like database normalization, as a text link, pdfEdit995 only
makes the first word of that phrase to a link. This is a bit disappointing, but you
just have to plan for cunning texts as links to bypass this problem. Furthermore,
pdfEdit995 does not mark your text as a hyperlink (blue with underline). You
must do it yourself as a link in your Word document.

Adding bookmarks: Choose Bookmarks:

Fage Hurnber B ookmark. Lirks Doclmfa

Add Bookmark |

Remove bookmark, |

Clear all bookmarks |

Save bookmark. lizt |

Mote; The last document
printed muzt not be open
inn the viewer. Add Bookmarksz to last POF created Help
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You need to have written down the header of each of your chapters, and their
page numbers first. Since you already have added page numbers, you can just
open the eBook, browse it and write down page numbers and the chapter title.
Then you close (!) the PDF, and start by clicking Add Bookmark:

Page Numi:er Bookmark | Lirks I Docl

Ad

Enter the Bookmark's page number:
|1_

Rem  Enter the Bookmark's title:

Cloar IIntdeuctinn

Save ok I Cancel |

hlmkme

and press OK. Your first bookmark is in place. Now choose Add sibling and add
the next bookmark, and so on, until you are finished. Note that you can create
hierarchies here by choosing Create child. You may experiment with this; I
haven’t studied all the possibilities.

Lastly, I put up a personal touch to the eBook: Choose DocInfo and enter your
own information:

Page Mumber I Bookmark I Linksz Doclnfa

Maote: The last document printed must not be open in the viewer.

Title IHDW to make an eBook - for Newbies

Subject I.-'i'x cost-free method to make vour own eBoak,

Authar I.-'l'-.lf Pedersen

K.ewwords IeEu:u:uk, writing

Open Mode INurmaI j [T Automatically insert Daclnfa inta all PDFs

Inzert Document Properties

and press Insert........

That’s all there is to it. You can now publish the result.
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Uploading your eBook.

Your eBook is ready: It has great content, it is full of useful (and profitable) links,
and you are ready to display it to the world. There is only one small problem: It
resides on your hard disk! And you have of course protected your hard disk with
anti-virus, firewall and everything; no-one gets in here.

You have to publish it, and you do that via your Website. You have to make it
visible and downloadable to the audience. If you don’t have a website yet, or you
think you can’t make one by yourself, don’t panic: I’'ll cover that part later.

If you manage your website with Frontpage or whatever, you already know how
to upload files. This chapter is intended for the many thousand of successful site-
owners that use SiteBuildIt!

Take the following script and place it in your eBook directory on your hard-disk.
Use a simple editor like Notepad. Modify the file name and description (shown in
red) to suit your own eBook. A word of warning: Make sure that the file extension
is pdf. Not PDF ! SiteBuildIt! does not accept upper-case in file extensions. Here
is the script which you save as whatever.html in your eBook directory on your
hard-disk:

<html>

<head>

<TITLE>Uploading</TITLE>

<META NAME="ROBOTS" CONTENT="NOINDEX, NOFOLLOW">

</head>

<body>

<a href="support-files/NewbieBook.pdf">eBook creation for
Newbies</a>

</body>

</html>

OK: Now upload the script into SBI! as a new page with this button:

K/ Upload vour Cwn HTML Fage

Follow the instructions carefully, but don’t mind any messages on optimizing or
whatever. The only purpose of this script is to upload the PDF file.

You have to go THROUGH Step 3 of the upload process: That’s where you
browse to your eBook directory on your hard-disk where your PDF file resides,
select it, and then upload it.

Do not Build! the page: After your eBook has been successfully uploaded, use the
Back button to get out of there (to Site Central).

That’s all there is to it, really.
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After you have done this, the eBook is placed up on your website, save and sound.
But your visitors don’t know yet. The next step is to make it visible and
downloadable.
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Make your eBook downloadable.

Your eBook is now placed up on the server together with the rest of your website.
But you must make it visible to your customers by placing a link to it on your
website. Again, this chapter is for highly successful © SiteBuildlt! webmasters
only.

The eBook you are reading now was originally placed on my For Webmasters
page. I did it like this: I opened the web page for editing, and on the bottom of it I
placed a text block with this text:

“Get your free eBook on how to make and publish your own eBooks on the
Internet. Right-click on the following link and choose a directory to save it in
(Left-click will open the eBook in Acrobat Reader. Make sure you have Acrobat
reader installed):”

Then I created a text link block like this:

? Text Link =
Delete this Black

Text |<h2>DDwnIDad the eBook on eBooks<hZs
Alignment Im
Choose Link |Nune j

IDR enter a new link below. .,

Mame this link |NewbieBDDkresuurce and

Enter URL b:um,-"auppun—filesfnewbiebuuk.pdf
MouseOver Text |Duwnluad the eBook ol
Open New Window? |ND, do MOT open new window j

In the URL field, specify the complete link; in my case:

http://www.databasedesign-resource.com/support-files/newbiebook.pdf

One vital information: No matter how you spell the name of your eBook (mix of
upper- and lower-case letters) use only lower-case in your URL, otherwise it
won’t be found!

That’s it; your eBook can now either be read directly by left-clicking on the link,
or saved (Save Target As) by right-clicking on the link, as a PDF file on your
computer.
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To show you how it once looked like on my For Webmasters page, look at this
snapshot:
Business disenssion formns

Allan Gardyne's Affliate website has waluable mftrmation on Internet business. He also
hosts a great discussion forum on Internet Busmess: Allan Gardyne's affibiate website

Create your own eBook: A free how-to eBook
CGret your free eBook on how to malce and publish your own eBooks on the Internet.

Right-click on the following link and choose a directory to save it in (Left-click will open
the eBook in Acrobat Reader. Make sure you have Acrobat reader installed):

Download the eBook on eBooks

Eeturn from Web Eesources to home

OK! You are in business! Not only have you written an eBook; you have
converted it into a sophisticated PDF with page numbers and a professional table
of content, you have uploaded it onto your own website, and users can download
it directly from your website! Well done!

In the next chapter, I will add an icon, or rather, an eBook cover, to it, just for
cosmetics. ..
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Creating eBook covers

I have had many emails with regards to creating eBook covers, so I will briefly
discuss the topic here.

Actually I really like those small 3D images of books on the net. They look like
real books, yet they only serve to marketing your electronic product, and to
visualize it. Here is a cover [ am quite proud of (I’m about to start writing the
book, but I couldn’t resist making the cover first ©):

DESIGN
f@r

- PEEFOHHHHCE

What do they say: Boys will be boys...

But as I see it, this is far better marketing than only a flat text with a text link.
Can’t help it, that’s how I think.

I searched high and low to find free SW to make covers, but I didn’t find it. There
was one package, but I found the quality not to meet my standards (I found it
through http://www.download.com , of course. I told you, remember?).

So I ended up buying a SW package. It cost me 50 USD, but it is really worth it. I
see some sites who are marketing that they will do a cover for you within five
days for USD 99 (that IS 100! I am not stupid...). But why should you, when the
software for creating an infinite amount of covers is half the price. You can do a
cover in 10-15 minutes.

I use covers both for eBooks, for Key Notes, and for some links, too. You can
check out my site
http://www.databasedesign-resource.com to see how I use it.

You can however, just use a graphics program to design a simple flat graphic icon
with tools you already have. Read the chapter on Handling graphics with ease.

17


mailto:info@databasedesign-resource.com
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.qksrv.net/click-1409730-8315146
http://www.download.com
http://www.databasedesign-resource.com

Ok, I will make a cover for this eBook on eBooks. I will fire up my eBook cover
SW and start working.

Back in 15 minutes.....

Ok, I’'m back. It took me 18 minutes, but [ had to do a couple of tries:

I just couldn’t resist that space thing: Boys will be boys. ©

Now I will provide this eBook cover for my website as well. Have to go, but will
be back in 10 minutes this time....

Back again.

Website ready, in 7 minutes, and it looks like this, with graphic link to the
eBook:

Download my free and helpful eBocl whenever it suits you. It's fiee,
the Internet, without the Internet Marketing amateurs runmng after yvou

Get your free eBook (641 Eb PDF file) on how to
with resources you etther already have mstalled on vo
| for free on the Internet.

Touneed to be a subscriber to my Newsletter to acc
unsubscribe anytine. Subscribe to the IMewsletter nos
confirmation of your subscription (i case someone 15
you will get an email with a hink to back-1zsues of the Newsletter. Tust
are offered to dewnload the eBoole

In my opinion, this IS better. A few surveys I’ve seen also point out that a 3D
presentation of an eBook enhances the message. Can’t really tell, myself, because
my site has not been to long in business.

The same link as [ have in my text link is also placed on the eBook cover. Test it
out on my site.

Last words: If you intend to write only one eBook, think twice about buying
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cover SW. If you are producing several, don’t think about it. Get it. Your products
will look much better.
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Creating money from your eBook

So far, we have covered everything (I hope) with regards to creating you very
own, personal eBook. But there is a final, very interesting question to be
answered: How can I make money from this eBook?

There are a few obvious points here: The eBook must have a market, you must
advertise it, it must have a placeholder (website) etc. That is not my job to talk
about. I will give you a walkthrough on the technical matter of it.

I use ClickBank to sell my eBook. Actually, I do the selling, but Clickbank does
the payment part of it. Read more at http://www.clickbank.com.

Here is a marketing page on my website:
http://www.databasedesign-resource.com/database-normalization.html

I made the sales icon myself. Since I’'m not good at graphics, I actually used
PowerPoint!!!

Click here for secure
ClickBank ordering now!
VisA S

Feel free to copy this image and use it, if you like it. See a later chapter on how to
do it.

It is a graphic with a link to ClickBank:

When the visitor clicks it he arrives here:

ClickBank® Secure Order Form

Please enter your country and postal code below. Make sure
your postal code matches the one on file with your bank.

Your country and state: |Greece j

‘four zip or postal code: |12345

Continue To Step 2 I
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The visitor has been sent off to ClickBank from my page (opened in a new
window) to pay for the eBook. After entering country, the customer is sent to the

next page:

ClickBank Secure Order Form

YWe do not store
account numbers

BEBBOMLinvE"
lil RELIABILITY
= PR AM

|Amex jlliﬂ leDEGj Card & expiration
| Your card number

I J-digit validation code on back of card

Mote: It is never legal to entersomeone else's card.

kust be correct

I Your name exactly as on card

I Your email address

Greece 12345

Subtotal $17 .00
Taxes £3 .06

Total 520.06

ClickBank Product Mame: "Database Mormalization"
Click Once To Fayw $20.06 (LIS Dallars)
By clicking the button you agree to our TERMS OF SALE below.

Terms Of Sale

As you can see, ClickBank even handles VAT processing for countries inside the
European Union. Very nice. After the customer hits the Click once...button and
the payment is OK, ClickBank sends the customer back to a new page on my site:
the SALES PAGE. This is a secret page I made: It has no links in to it, so you will
never find it: It is created only for receiving traffic from the ClickBank Secure

Order Form.



It looks like this:

DATABASE DESIGN RESOURBE

Thank you for ordering
your copy of the Database
Normalization lecture!

You will find your download link below
for the eBook on Database
Mormalization, The eBook is in PDF
format (approx. 450 Kb),

If you hawve any problem downloading
it, contact our sales service,

Important
notes:

Please take a moment to
read these important
nntas

This page has a link on it for downloading the Database Normalization eBook, in

exactly the same manner as we did with this eBook earlier on.
How to set up this?
You must be a customer (a merchant) with ClickBank. Use this link, and read:

http://www.clickbank.com/overview.html

Start reading; it is quite a lot.

The basics are these: You have to open an account with them. It will cost you 49
USD. It is a one-time cost. For each sale they will charge a small fee of the price
of your eBook. This is deducted from the price the customer pays. Fair enough. If
your price is 24.95 USD, you will receive 22.09 USD of that.

You can sell up to 50 products (eBooks) with one account.

ClickBank can only be used to sell electronically distributed products, like
eBooks. Fine, that was what we were looking for in the first place. ©

There may be other arrangements as well, but I don’t bother to look further:
ClickBank works OK for me, at least so far.

When you sign up with ClickBank, you’ll get all necessary instructions on how to
setup this auto-pilot sales machine, that will sell for you 24 hours a day, 365 days
a year. You only need to pay attention to one small detail: The mailbox outside
your house. That’s where a check from ClickBank arrives once each month...
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Handling Graphics

I have used quite a lot of graphic illustrations in this eBook. For those clever
computer users this is quite simple, but then again, this eBook is not written for
them. I will therefore explain a little about how you can use graphics yourself,
with software you already have installed on your computer.

In Accessories, you have a program called Paint. It is not a very sophisticated
program, but it does the trick for many tasks. Here is how you can use this little
program:

Let us together make a smart little icon, and place it into some small
HTML/Javascript code (Don’t go away: I’ll do the programming, you’ll get the
result ©). We shall make a smart little wizard that automatically lets your visitor
add your website to his/hers favorites. Here is what [ want you to do: Start
Internet Explorer now (That’s the browser that this code will work with — others
won’t work). Press down the Ctrl key, and while holding it down, press the Print
Screen key. This will make a copy of your screen on the computer’s clipboard.

Start Paint. You do it like this: Choose Programs -> Accessories -> Paint

Choose Edit -> Paste

The screen image is now right before your eyes. Click on any button (this is to

“freeze” the image), then click on the ] button. Place the cursor in the upper
left point of the menu choice Favorites. Hold down the left mouse button and
drag a rectangle over the area you want a copy of. Now let go of the button. You
will have something like this:

{§ untitled - Paint

File Edit View Image Colors Help

/3 Google AdSense - Reports - Microsoft Internet Explorer

J File Edit View Favoritesy Tools Help

o

JOB&CK il > B ﬂ Q ;‘] ‘ p, ) Search u‘ Fas

Notice the rectangle around the area for Favorites.
Choose Edit -> Copy.
Then select File -> New.

You will get the question:

Paint x|

L] "_n., Save changes ko untitled?
L

Yes il | Cancel |

Your answer is a clear, firm No.
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Here is a little trick with Paint. When you start it (or select New), it might come
up with a large white canvas. Minimize it by clicking in the lower right corner and
push the canvas up and to the left, until it becomes as small as possible: We don’t
want a large white area in our image. NOW: Choose Edit -> Paste

This is what you get:

i untitled - Paint

File Edit Wiew Image Colors Help

Favorites

That’s all for graphic handling! All we need to do now, is to save this, so that we
can upload it to our website’s image library later (this you should know how to
do). Choose File -> Save, and you will get this dialogue:

savens M E TRk

Save i M_I.J Fictures j (€] ._?'- % |FRE
==
I-—-J
Micrasoft Clip Oroanizer Picture Sample Pictures

File name: untitled j Save I

Save az hupe: 24-bit Bitmap [*.bmp;”. dib] j Cancel
Monachrame Bitmap [*.brmp;”. dib)

&—

16 Calor Bitrap [* brop.*. dib)

;" dib

256 Color Bitmap [*.bmp
24-bit Bitrnap [*.brop;” dib]

JPEG ["JPG;*JPEG:"JPE;*JFIF]
GIF [*.GIF]

TIFF [".TIF; " TIFF]

PHG [*PMG]

Choose the catalog for Save in. You should have a catalog somewhere on your
disc for graphics?
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It was me that opened the Save as type: I did it so you could see the choices. Paint
will recommend the BMP format for you, but you should choose JPG : it takes
only 25% of the volume of the corresponding BMP format (makes it load 4 times
faster on your website).

No write your filename instead of ‘untitled’. Why not call it Favorite ?

One last note: With your Windows Explorer (no, not Internet Explorer), check
that the file extension is in lower-case. If it’s not, change it to lower-case (If you
are an SBI! owner, SBI! doesn’t allow upper-case in file extensions.

Upload the image to your website. We are almost there now. After all, this
chapter is written to teach you some basic graphics skills. I believe that after what
we have been through now, you will soon be a graphics wizard; don’t you ©

Now, let me do some programming, while you take a break.
I’m fast; I’m back with this little code:

<P>PS: Why don't you add this page to your <script language="JavaScript"><!--
if (navigator.appName = '"Microsoft Internet Explorer') &&
(window.clientInformation.javaEnabled() == true )) { document.write("<SPAN
STYLE='cursor:hand;'onmouseover="window.external. AddFavorite(location.href,
document.title);"><img src="http://www.yourdomain.com/images/Favorite.gif'
alt="></SPAN>"); } else { document.write("<img
src="http://www.yourdomain.com/images/Favorite.gif' alt="Dont forget to
Bookmark!">"); }// // --></script> DS.<br><br>

I know this looks like Chinese, but don’t bother about it. Here is what you do:
Copy the above code into your text editor, change yourdomain to your own
website name, and copy the finished code to where you want to place it on your
webpage(s).

Note: The /images/ catalog is for SBI! users. If you’re not using SBI!, you’ll
know best where to place the image.

Final test: Go to my homepage at http://www.databasedesign-resource.com . You
should find it in action somewhere down the page. Move the mouse over the
Favorite image: Scary? Without even touching the keyboard or clicking on the
mouse, the following window pops up: This is SO effective, I have even
bookmarked my own homepage by mistake. Several times!
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Add Favorite el |
i\\? Internet Explarer will add this page to your Favarites list.

[~ Make available offine Customize, .. | Zancel

Mame: I The Database Design Resource Center Create in <<

Create in: [ Favarites Mew Folder...

-~ Affiliate
[+ databasedesign

-4 Dell
-4 IkToolbox

43 Links
- Cracle
{7 Privat

i

This concludes the first section of this eBook on making eBooks. Hopefully, you
have learnt a few tricks, and as you have seen, you CAN make eBooks and
publish them on the Internet without spending five cents, provided you have a
computer, an Internet website, and the most basic and common tools in the
industry (a word processor like Word, and a simple graphics program like Paint).
Furthermore, you can make professional eBooks covers in infinite numbers for
half the price that some website services charge for only one cover.

This eBook took me most of the days of Dec. 25/26. 2003 to write, and all
because I had neglected an email in my inbox for 12 days, which did so much

damage to my consciousness that I had to start writing this. It was last updated in
Sep.2004.

In the next chapter, I will go into detail on how I created my website; my
“empire”. I will show you some very interesting search engine figures, tricks and
some details on the tool I am using. See why you will find MY website in the top
10 out of thousands of websites when you search on Google for 'ref cursor
oracle', instead of Oracle Corporation™. [ will also provide you with links to tons
of free information for direct download to your PC. That information will show
you how you can successfully create a website of your own, AND get interested
buyers to visit you every hour, making money for you even when you are asleep.

Together, the next chapters will provide you with a lot of free eBooks and free
courses on how you most effectively can build a future business for yourself.

How do I know?

I did it, and you visited me for this eBook (or someone who wants your best, sent
it to you) ©

Just get yourself another cup of coffee, then turn the page and let’s get going...
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Building your own future and an Internet Business

As said earlier, you read this because you (or someone you know) navigated to
my website

http://www.databasedesign-resource.com, and found this eBook on how to create
an eBook. By the way, this eBook is absolutely free, but you cannot copy it or use
it for commercial purposes. And why should you; make your own eBook instead,
like you have learned earlier.

eBooks (some call them infoproducts) are a fast-growing part of the Internet
world: People are seeking information out there. The Internet contains huge
amount of free and easy accessible information, but often information is placed in
downloadable books like this one, and called eBooks. Of course you could rather
be interested in selling hard goods, or your own services, skills and/or talents.
Whatever you possess, it is probably possible to sell it. Personally I write eBooks
and put them for sale on my own website, but you probably know that already ©

Since you know how to produce an eBook, I will provide you with further
resources so you can sell your eBook and make a profit on it, big or small
(depending on demand and supply). After all, you wouldn’t have read this eBook
as far as this if you weren’t thinking about how you could do it? Perhaps this little
eBook is what it takes for you to get a head-start?

You WILL need a website to do this.

Do NOT go out and grab yourself a website now; I will return to that later.

Do NOT think you can’t make it: I’'m “talking” on the Net each day with
webmasters that don’t have any idea about computers and software (well, almost,
you need to know how to use one...)

I will tell you about the tools I’'m using myself.. I will tell you about ALL the
tools I’m using. Some of them you already know, some you don’t.

It is actually quite simple: I use a complete tool which is called SiteBuildIt!.
Without it, [ would probably not have built my own website, and [ know many
people out there who, without it, couldn’t have done it!

But if you are considering going for your own business, you should prepare
yourself: Learning basic concepts and getting an understanding of what you are
entering into first. On the following pages, I will provide you with free readings
on several subjects. I am sure one of the subjects will fit to your interest and
knowledge.

I could have written pages and pages about this subject, but the stuff has already
been written for me, and much better than I can do, so turn the page to start on
your education and preparation for something that, worst case, will bring your
hobby or interest in front of a world-wide audience, and, best case, will allow you
to quit your job and make a living from your home, out on the World Wide Web.
And many are right in the middle: Earning enough to buy a better house, another
car, or having a great holiday with their families each year ©. I do.
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How I built an Internet Business

I’d like to tell you a little about how I built my little “empire” (my website) on the
Internet. Actually, it was my daughter who gave me a little kick in the a.. : “You
know a lot about the database industry. Why don’t you make a business out of it?”

I told her that I had a full-time job, and besides, I had absolutely no knowledge
about the Internet when it came to Internet programming. My field is high-
performing, large databases, residing on large computers in the back-offices.

But my daughter kept on: “I have a friend”, she said, “who knows nothing about
computers, except how to use them to write and run the ordinary, well-known
programs. He has now started earning money on the Internet, selling other
people’s products. And he has built his own website with a standard toolkit. He
doesn’t own any of the products he’s selling. I think you could do it better: you
could make your own products and sell them all over the world”.

Now, that was some challenge!

Now, nine months later, I have to give credit to my daughter for being absolutely
right: It IS possible: You can see my website here:
http://www.databasedesign-resource.com . This site has hundreds of visitors from
all over the world (more than 80 countries/month) each day, and increasing each
month; more than a thousand subscribers to my newsletter (increasing each and
every day). The popularity of this website is increasing day by day; but it is still in
its infancy, and I can measure its growth day by day by powerful statistics.

The best part: It is ticking in money each and every day, regardless of whether
I’m there or not: It is going on autopilot, 24 hours a day, 365 days a year, whether
I’'m sleeping, going fishing, or if I am at work! Imagine that: This website is
earning money each hour, every hour of the day, every day of the year. Read me
right, though: It is (so far) residual income, but I walk to the bank twice a month
with my checks. I have three income streams:

. My own (first) eBook; more to come
o Adpvertising income from Google
. Selling infoproducts for others and earning a commission

Notice: Only one income stream is from my own product!

Wed 01:38 PM invoiced@clickbank.com CB all
Wed 10025 AM invoice@clickbank.com CB all
Tue 11:38 &AM invoice@clickbank.com CB ali
Am L o Aamm A HITETI -ty — R - P PR [y sl I V|

I really enjoy those emails from ClickBank!
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I will in the future also be selling software, as well as I will be increasing the sale
of infoproducts from other sources. There are thousands of products to choose
from at ClickBank and other affiliate systems on the Net, both software and
eBooks. Some pay more than 50% commission, some pay less. It’s your choice

what you want to sell.
I myself have opened my first eBook to affiliates with Clickbank, with a 50%

commission: Last time I checked, there were more than 30 different websites
around the world who were promoting my eBook. That’s more than 30 “Internet
stores” offering my product! And they are at it 24 hours every day, 365 days a
year, just like my own website!

Last summer, on a one-month vacation to Italy with my wife, I went into an
Internet café in Rome, logged into my system, and checked sales: How many
eBooks sold, how much in advertising income, how’s traffic. I did a few changes
to a couple of my web-pages, logged out, and continued on my holiday. I can run
my business from wherever, as long as [ have access to a computer with an
Internet connection. Geography is no limitation to me, and it will not be a
limitation to you either.

It started very slowly: After being convinced by my daughter, I made an
investment in SiteBuildIt!, comparative to a night on the town for two (at least in
Europe/America®©), and started to read.

That’s right; I had to prepare myself for how I should go about building my
“empire”. Remember, as I said, this was really not my field...

This was one of the most inspiring experiences I have had: The free eBooks I
downloaded contained revealing, easy-to-understand stuff I could read and relate
to, written by people who had “been there, done that”. It gave me the foundation
for all my work ahead (make no mistake, you have to work for success). It also
gave me the firm belief that I really could make a difference.

I used my Christmas holiday to write most of my site. I wrote text in my text
editor, and then copied it into the appropriate places in my building tool.

The first two months were not encouraging. Little traffic and no income.
Then one day, traffic started to flow to my site. What had happened?

I had been discovered by Google. That’s right: The world’s largest search engine
had noticed me, and had found out that it might be interesting to let other people
know about me. From then on, my site started climbing in popularity, and it is still
climbing, faster and faster.

Today, my website is ranked well by all major search engines like Google,
Yahoo!, AltaVista and AskJeeves, and an unknown number of the smaller ones.
To be noticed, and ranked as high in the search engines as possible, is the most
important factor to get visitors to your site. Here are some search results I have
noticed (remember, results can fluctuate in time. These results are all taken from a
given time):
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First, let me show you a clip from my statistics for a given month:
| Top 50 of 725 Total Keywords

# | PageViews Keywords

| 1 | 25T| 15.10% |refcursu:ur

See, 725 different phrases was used to find my website! One of them was ‘ref
cursor’; that phrase alone was used 257 times so far that month alone (ref cursor
is an important database programming concept). Imagine the total for all 725

keywords! Per month! Let us do a Google search for ‘ref cursor’:
Nett BDilder Grupper Katalog

Go (nge = 5] e

@ Sk pd nettet © Sek gjennom sider innen norsk(e) (hokmal)

Nett Fesultater 1- 10 av ca. B4 100 {

Using a ref cursor in Oracle PL/SQL

Using a ref cursor in Oracle PL/SCL. ... Ref cursor information is highly sought after Il
The web statistics show that this is an important page to visitors. ..

wewy, databasedesign-resource. corm/ref-cursor.himl - 28k - | hurtigbuffer - Lignende sider

84.100 websites were found that talk about ‘ref cursor’. My website is in the no.1
position. Not Oracle Corporation™ (They invented the term ref cursor). Not
Microsoft Corporation™. Not IBM™. Just me.

My primary goal with my website is to share information and knowledge about
my field of work, and write eBooks for database design. Let us try a search:

This places me as number 1 and 2 out of approx. 340.000 websites. Competition
is far behind.

Web Images Groups Mews Froogle more »

GO ngle |datahase design ebooks Search | w

Web Results 1 - 10 of about 338,000

The Database Design Resource Center

... Wisitorville.com eBooks lectures in database design eBooks lectures in database
design with emphasis on performance, normalization and tuning. ...

wew. databasedesign-resource. com/ - 28k - 8§ Sep 2004 - Cached - Similar pages

eBooks lectures in database design

eBooks lectures in datal lesign with emphasis on performance, normalization and
tuning. ... Return frorm eBooks Central to Database Design home. Visitorville.com.
wew. dlatabasedesign-resource. com/eBooks. html - 32k - Cached - Similar pages

[ Mare results frorm wwe. databasedesign-resource.com |
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There are 6.750.000 websites out on the Internet that have the phrase ‘analysis
phase’ in them. AskJeeves ranks me as no. 3. By the way, Google ranks me as no.
8 for that phrase. Note the absence of all the world’s major consulting companies,
as well as software development corporations, medical companies, or any other
major analysis brain centers. Only my brain (?) center. Not bad.

|ana|\;sis phase Search |

Q% Search: ® web  Pictures © News  Products

sfpeves”

Web Results

Instructional System Design (I50D) - Analysis Phase

Instructional System Design - Analysis Phase. The Analysis Phase. Analyze The Sys:
Select Tasks. Needs Analysis...

sy, mewlink, com/~ donclark fhrd/sat 2 hitml

SEL-£1-305 Recommended Approach to Software Development Revision 3 (RI
5§ Section 3 . The Requirements Definition Phase ... 21 Sectic
Analysis Phase. .,

sel.gsfc.nasa gov/website/documents/online-doc/81-308new . pdf

The Analysis phase - The starting point of effective Database Design

The Analysis phase - The starting point of effective Database Design. This is aseries «
issues in the database analysis. ..

www, databasedesign-resource. com/analysis-phase.html

From time to time, we need to look up a word in some kind of glossary or

dictionary. I focused on the term ‘database glossary. Let’s do a search:
Web |mages Groups MNews Froogle more »

Go Ug[e [abase glossay St | st e

Web Results 1- 10 of about 6,280,000

Databases Glossa

... Search. Databases Datahases Glossary. <Back to Last Page> ABCDEFGHIJK
LMMOPQRSTUNWXY Z#Can't find the word you're looking for? ..

databases about.com/library/glossary/blglossary.htm - 28k - Cached - Similar pages

Databases Glossary

... Search. Datat Datak Gl y. ... What's Hot. Databases GlossaryAccess Books

for BeginnersBuilding an Access Database...Foreign KeyAggregate Functions in SQL ..

databases about. comdlibrary/ glessary/blglossary. htm?Pl=5513_databases - 28k - Cached - Similar pages
[ More results from databases about corm |

Mavie Terminology Glossary
WABCDEFRGHLLKLMMOPQRSTUY. WK Y L [Index].
IMDb Filim Glossary. Welcome to the Internet Movie Database’s online filin ...

weoew. imdb. corm/Glossary! - 17k - B Sep 2004 - Cached - Similar pages

TDB Glossary
Defines a wide range of terms and concepts specific to the temporal database research community
w5 auc. dki~ceifGlossary/ - 1k - Cached - Sirnilar pages

Household Products Database

Household Products Database Glossary Topics. ACGIH. The American Confarence

of Governmental Industrial Hygienists, Inc., (ACGIH) deals ...
hougeholdproducts.nim.nih.govhouseholdGlossary.htm - 101k - Cached - Similar pages

Database Glossary Important database design terms in database ...
Database Glossary in Design. A database glessary is needed. ... Return from Database
Glossary to Database Design home Yisitarville.com.

wennwy. clatabasedesign-resource.com/database-glossary. htrl - 20k - Cached - Similar pages

My site is no. 5 out of 6.280.000. So, my site, amongst several million websites
on the Internet, is viewed as one of the 10 most valuable resources for a glossary
on databases! Guess if [ am considered to be an expert... (Actually, I am quite
good in my field. But then, so are probably you in yours.©)
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Here is one I will improve on (But really, being ranked as 27 out of 23.600.000
websites is not bad at all for such a general and important phrase as ‘database
design’, above Oracle™, IBM™ and Microsoft™):

YAHOO! search

Results 21 - 40 of sbout 23,600,000 for database design,

27. The Database Design Resource Center =
A Resource Center for DB Professionals seeking solutions to database design «
design . Sharing Secrets of Highly Efficient Database Design. YWelcome to The
wonewd databasedesign-resource. comd - 25k - Cached - More pages from this site

OK, enough of that: I could go on for hours. © It is important to be in the top 10:
You are seen immediately by the searcher.

By judging from the above, you must think [ am a Web genius? Well, some times
I feel smart, but other times... Actually, the true answer, and I hate to admit this,
is: I don’t know anything about how this happens! I have never understood what
goes on inside those big search engine corporations and how they decide what’s
important and what’s not..

The good part is, [ don’t need to. You won’t, either: The toolset I use does it for
me. It may sound unbelievable, but it is true.

I guess I have to show you an example: Whenever [ make (that is: write) a new
page to my website, I check it first (BTW: Graphics, links and other stuff is
handled in a similar, easy way). [ have four buttons at my disposal:

Frewview [ Analyze il | g/ Build It! Pricrity Build [ |

With Preview, I can see the page exactly as it will appear when you visit it. So if [
have made errors of any kind, I can correct them before I publish a new page.

The Analyze button is the top secret of my high rankings on the Internet: It is
checking every single element of my webpage before I publish it, to make sure it

will hit right in the face of all search engines!

That function alone is worth more than the price (remember: Dinner for two on
the town?) I gave for the whole system!

Let us see what happens when I push the Analyze button: (SEO=Search Engine
Optimization)
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Here's how well your page fits a good solid, SEQ strategy...

Good.
Good.
Good.

Your Specific Keyword is not in the DESCRIPTION box. Please include it at least
once, EXACTLY the way that you entered it in the KEVWORDS box for this page,
and no more than twice, Click here for more detailed help on this subject.

Your Specific Keyword does not appear in the first 90 characters {i.e.,
numbers, letters, and spaces) of your BODY copy. Please include it once,
EXACTLY the way that you entered it in the KEYWORDS box for this page. Click
here for more detailed help an this subject.

Not too good: I have a bad description of the page, and not a good start for the
text, either. Have to go back and change things, then analyze it once more:

Here's how well your page fits a good solid, SEQ strategy...

Good.
Good.
Good.
Good.
Hoadtins |
Good.
poge
Good.

Everything is good!!! How about that. Now I know that my new page will
perform as good as possible against the competition. Even better; since most of
my competitors probably don’t use the same tool as me (thankfully), I will
outsmart them. (OK, my tool will do it).
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I can now press the Build button. When I do, I get this:

Here's What Happened...

I have built this page. I have also referred it to Site Build It! WorldSubmitter.

This SBI!-proprietary page-submission program will send this page to the major global
Search Engines, as well as to other carefully selected and impaortant regional engines,
but only if it actually needs to be submitted.

{Click here for more information.)

Goto Site Central |

My tool also takes care of notifying all the search engines that I have made
another page, and would they please put it as high as possible in their listings!

This is a killer: Without functions like these, I would be in the dark: Never
noticed, with poorly constructed pages, never to be found by anyone. In other
words: Out of business.

Instead, I’'m a happy website builder, with lots of (increasing) traffic, happy
customers and visitors, and income each day.
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Building a business without products
Is it possible to build an Internet business without products?
Yes, it is.

I told you earlier about my three different income streams. One of them is selling
my own eBook(s). As of now, I have my eBook on Database Normalization up
for sale. It is also registered with ClickBank as a product others can sell, with a
hefty 50% commission per sale.

Well, since I sell the Database Normalization eBook, I thought I should check out
how it did on Google (yes back to the search engine again). Now, LOOK at what I

found by searching for ‘database normalization ebook’ on Google:
Web [mages Groups Mews Froogle more »

GO L)gle |database normalization ebook search | w

Web

Database Normalization Technigues - Essentials and techniques

.. Database Normalization eBook Table Of Contents. The five Normal Forms. ... How to
order. The Database Normalization eBook is an easy download. ..

wrw. databasedesign-resource. comn/ database-normalization. htrml - 10k -

Cached - Similar pages

Database normalization - Creating high performance from the start.

.. Get the complete Database Normalization eBook here. In the following keynote, taken
from the eBook on Database Normalization, we ...

wrw. databasedesign-resource. com/normalization. html - 17k - Cached - Similar pages

[ More results from wwew. databasedesign-resource. com |

Database Normalization - Discover and apply the techniques in your ...

.. Database Normalization eBook: Table Of Contents. ... Upon successful payment you
will return to our site to make the download of the Database Normalization eBook. ...
wrwy dthstar net/products/bZb. education/ link2media. alfaped/index. php - 9k -

Cached - Similar pages

Database Normalization Techigues - Essentials and technigues

.. Database Normalization eBook Table Of Contents The five Normal Forms This eBook
will review all the 5 Normal Forms in database normalization normally used to ...

wnney. dowenloadfrestrial.comfcomputing database-normalization-ebook html - Sk -

Cached - Similar pages

Programming - Database Normalization eBook

.. as Oracle, 3QL Server and others. Database Normalization eBook. ... Server and others.
Database Mormalization eBook. Comprehensive eBook on ...

wewnee worldssp.net/store_web/ 3008-Database-Mormalization-eBoak. htm - 20k -

Cached - Similar pages

Normalizing Data

«. This eBook will review the 5 Normal Forms in database normalization normally used to
ahalyze data models in the making. There are ...

wewie accessdatabasetips comdnormalizing-data html - 11k - Cached - Similar pages

Best Euy - Database Normalization eBook

Database Mormalization eBook Home | Buginess to Business | Education | Product
Details, Database Normalization eBook. Cormprehensive ...

wewnee shopping-bestbuy. comd Database-Mormalization-eBook-product-49 bt - Bk -
Cached - Similar pages

Study this snapshot very carefully: I am No. 1 and 2 for this phrase (beginning to
be boring, am 1?), but the interesting part is: what about the others, further down?
The next 5 after me, are affiliates; that is: They are selling MY eBook! How about
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that! One of them claims: “Best buy”. Smart guy. Who am I to argue? ©
Actually, 8 out of 10 amongst the top 10 are part of my sales force. Have I asked
them to? No.

They have all gone to ClickBank without me knowing it, and gotten the correct
affiliate link, and placed it onto their websites. It makes them happy to have yet
another product to sell. And it makes me happy that they are selling, amongst
other things, my eBook. Actually, amongst Google’s top 30 for the phrase
‘database normalization ebook’, more than half of the hits are websites promoting
my eBook in one way or the other. And yes, they get sales.

This is the affiliate business: Selling other people’s products.

Actually, most businesses on the Net do that. Few will take the work to produce
their own product(s). I will, and since I allow others to sell it, ClickBank
announces that for me, and “Internet stores” (other websites) grab my product and
put it for sale.

So you see, even without any product at all, you can be in business.

You can even get Google to pay you! Yes, that’s right: Here is a snapshot from
my site:

DATABASE DESIBN RESCOURGBE

Database normalization - Creating high
performance from the start.

Home

Database normalization is not a theory - It is a set of clearly defined rules that, when followed, without
eBooks exception should give you a much better performing finished system right from the start of your analysis

Design Workshop [kt
N el s by Goooooadle

Database Mgmt Systems
Al"ICINSB Phase Real-Time Integrated Data in Post- Relational DBz, Download Caché

Primary Keys Mawe

. intersystems. com/mateh25
Architecture

Get Database Mamt Papers
Programming Free YWhite Papers and Reports Download Free Information Here,
i, bitpipe. com

You see the small links? They are ads that [ have placed around on my site.
Google is checking the content of each page on my site, and delivers ads that are
relevant to my text: Targeted ads. They serve two purposes:

. When a visitor clicks on an ad, I earn money. Google won’t allow me to
tell you how much. It’s part of my deal with them.
. If a visitor doesn’t find what he is searching for, I can provide ads that link

to other sites of more interest to him. I thereby offer even more content than what
is inside my website.

Safe to say, [ walk happily to the bank every month, cashing in a check from
Google. Not only do they place my website high in their engine; they send me

36


http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html
http://buildit.sitesell.com/Eilen.html

money every month. I like Google. Again, I earn money even if I didn’t have any
product.

You can, too. These are only two ways of building your Internet business without
a single product. There are more ways, and you will find out, when you follow the
links to the tons of free and inspiring information I’'m showing you later. You
have nothing to lose and everything to win by following the advices contained
therein.
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How you can do the same thing

I would like to give you the same opportunity: Here and now, I would like you to
stop reading this, and rather start to investigate what you want to do forward on.
Everything you will find there is completely free to use for you. You will be
leaving my eBook, but I’'m sure you’ll return later. ©

The links below will provide you with tons of free information on how you can
succeed in building up a successful business from your own home, in your spare-
time, and at a speed you feel comfortable with. It is not done in a day, as so many
“get-rich-quick smart guys” out on the Internet want to sell to you: You have to
do some work. I had to do it. I have shown you that it is possible by what I have
done.

But first of all, you will need more information, so you can decide what is right
for you. I am very happy with the choices I have made, and I would like to share
it with as many as possible. The eBooks you are about to read, have been used by
thousands of people (including me) to help them build their own businesses. If
you read them carefully, I can guarantee you will jump in your chair. I did. And I
took action, and got out of that chair. Soon, you may be able to use the title
‘Webmaster’.

Start reading about your future possibilities here:
FreeBooks

When ready, start building your future here:
SiteBuildIt!

The Site Build It! Guarantee

Purchase 8BI! today, Use it. Even register vour
domalin hame (Its included in the price). If at any
point in tme 8BI! does not exceed your
expectations, we will refund vou immediately and
vou can keep the domain name that you
reqistered a5 our thank-yvou for qiving us & chance
St your business, Only by trving can you discover
what you and S8BI! will accomplish together, And
we take all the risk while you try,

Mo other package comes with this Guarantes of Success,
because quite frankly, there is nothing else

that compares to Site Build It!.

"TVenture nothing,
and life is less than it should be.”

Malcolm Forbes (1919-1990)

Good luck with your new business.

Alf Pedersen

Webmaster
http://www.databasedesign-resource.com
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